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Product notice

This guide describes features that are common 
to most models. Some features may not be 
available on your computer.

Not all features are available in all editions 
of Windows 8. This computer may require 
upgraded and/or separately purchased 
hardware, drivers, and/or software to take full 
advantage of Windows 8 functionality. See for 
http://www.microsoft.com details.

http://www.microsoft.com


Safety warning notice

WARNING! To reduce the possibility of heat-related injuries or of overheating the device, do not 
place the device directly on your lap or obstruct the device air vents. Use the device only on a hard, flat 
surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft surface, such as 
pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact the skin or a soft 
surface, such as pillows or rugs or clothing, during operation. The device and the AC adapter comply 
with the user-accessible surface temperature limits defined by the International Standard for Safety 
of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description HP Spectre x360 
Convertible PC

HP Spectre Pro x360 
Convertible PC

Product Name HP Spectre x360 Convertible PC ×  

 HP Spectre Pro x360 
Convertible PC

 
×

Processor ● Intel® Core™ i7-5600U 2.60-
GHz (SC turbo up to 3.00-GHz) 
processor (1600-MHz FSB, 
4.00-MB L2 cache, dual core, 
15 W)

 ×

 ● Intel Core i7-5500U 2.40-GHz 
(SC turbo up to 3.00-GHz) 
processor (1600-MHz FSB, 
4.00-MB L2 cache, dual core, 
15 W)

×  

 ● Intel Core i5-5300U 2.30-GHz 
(SC turbo up to 2.90-GHz) 
processor (1600-MHz FSB, 
3.00-MB L2 cache, dual core, 
15 W)

 ×

 ● Intel Core i5-5200U 2.20-GHz 
(SC turbo up to 2.70-GHz) 
processor (1600-MHz FSB, 
4.00-MB L2 cache, dual core, 
15 W)

× ×

Chipset Intel processor controller 
hub (PCH)

× ×

Graphics Internal Graphics: Intel HD 
Graphics 5500

Support for HD decode, DX12, 
and HDMI

× ×

Panel 13.3-in (2560×1440), BrightView, 
quad high-definition (QHD), white-
light emitting (WLED), UWVA, 
TouchScreen with flush glass and 
MultiTouch enabled; eDP1.3+PSR 
at 72% Color Gamut (CG), 16:9 
ultra-wide aspect ratio; typical 
brightness: 340 nits, (2.55-mm)

13.3-in (1920×1080), BrightView, 
full high-definition (fHD), WLED, 
UWVA, TouchScreen with flush 
glass and MultiTouch enabled; 
eDP1.2 at 72% Color Gamut (CG), 
16:9 ultra-wide aspect ratio; 
typical brightness: 340 nits, (2.85-
mm)

× ×
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Category Description HP Spectre x360 
Convertible PC

HP Spectre Pro x360 
Convertible PC

Memory Support for LPDDR3-1600 
dual channel

Supports 8192-MB (256-
MB×4×16×4PCs) and 4096-MB 
(128-MB×2×32×4PCs) 
configurations

× ×

Primary storage Support for single PCIe / SATA M2 
solid-state drive configuration as 
storage (scope M2 2260/2280 DS 
solid-state drive) 
in the following configurations:

● 512-GB solid-state drive 
supporting three-level 
cell (TLC)

● 256-GB solid-state drive 
supporting TLC

● 128-GB solid-state drive 
supporting TLC

× ×

 Support for single PCIe / SATA M2 
solid-state drive configuration as 
storage (scope M2 2260/2280 DS 
solid-state drive) 
in the following configurations:

● 256-GB solid-state drive self-
encrypting drive (SED) 
supporting multi-level 
cell (MLC)

● 180-GB solid-state drive 
supporting MLC

● 128-GB solid-state drive 
supporting MLC

 ×

Audio and video Webcam: HP TrueVision Full HD, 
fixed (no tilt), with activity light, 
1920×1080 by 30 frames 
per second

Dual array digital microphones 
with appropriate beam-forming, 
echo-cancellation, noise-
suppression software

Support for voice recognition

HD Audio (Realtek ALC3242)

Two speakers

× ×

Wireless Integrated wireless local area 
network (WLAN) options by way 
of wireless module

Two built-in WLAN antennas 
(in display assembly)

Support for Miracast and Intel 
WiDi Pro

× ×
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Category Description HP Spectre x360 
Convertible PC

HP Spectre Pro x360 
Convertible PC

Wireless (continued) Support for the following 
WLAN modules:

● Intel Dual Band Wireless-AC 
7265 802.11 ac 2×2 WiFi + 
Bluetooth 4.0 Combo Adapter

×  

 ● Intel Dual Band Wireless-N 
7265BN 802.11 b/g/n 2×2 
WiFi + Bluetooth 4.0 
Combo Adapter

×  

 ● Intel Dual Band Wireless-AC 
7265 802.11 ac 2×2 WiFi + BT 
4.0 Combo Adapter

 ×

 ● Intel Dual Band Wireless-N 
7265BN 802.11 a/b/g/n 2×2 
WiFi + Bluetooth 4.0 
Combo Adapter

 ×

External media cards HP multiformat Micro Digital Media 
Reader Slot with push-push 
technology. Reads data from and 
writes data to digital memory 
cards such as Secure Digital (SD).

× ×

Ports ● AC adapter HP Smart plug 
(4.5-mm barrel)

● Audio: one combo audio-out 
(headphone)/audio-in 
(microphone) jack, supports 
jack auto-detection

● DisplayPort 1.2

● High-definition multimedia 
interface (HDMI) v.1.4b, 
supporting up to 1920×1200 
at 60 Hz

● USB 3.0 (2)

× ×

Keyboard/pointing 
devices

Full-size, backlight, island-style 
keyboard

Touchpad requirements:

● ClickPad with imaging sensor

● Multi-touch gestures enabled

● Taps enabled as default

● Support for Microsoft® 
Windows® 8 modern 
TrackPad gestures, drivers 
for Windows 7 Professional

× ×

Power requirements Support for 65-W HP Smart 
adapter (non-PFC, EM, 3-wire, 4.5-
mm) and 45-W HP Smart adapter 
(non-PFC, RC, 3-wire, 4.5-mm)

× ×
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Category Description HP Spectre x360 
Convertible PC

HP Spectre Pro x360 
Convertible PC

Power requirements 
(continued)

Support for a 3-cell, 56-WHr, 4.96-
AHr, Li-ion battery (includes cable)

× ×

Security Support for Trusted Platform 
Module 1.2 (TPM)

× ×

Operating system Preinstalled: Windows 8.1 ×  

Operating system Preinstalled:

● Windows 8.1 Chinese 64-bit 
(only available with PRC 
Country Loc)

● Windows 8.1 Emerging 
Markets 64-bit (available only 
in Africa-English, Asia-Pacific, 
Russia, Saudi Arabia, 
and Turkey)

● Windows 8.1 Multilanguage 
64-bit

● Windows 8.1 Professional 64-
bit

● Windows 8.1 Professional 64-
bit Education

● Windows 7 Professional 64-
bit

Certified: Microsoft WHQL

Web-only support:

● Windows 8 Chinese 64-bit

● Windows 8 Emerging Markets 
64-bit

● Windows 8 Multilanguage 64-
bit

● Windows 8 Professional 64-
bit

● Windows 7 Enterprise 64-bit

● Windows 7 Enterprise 32-bit

● Windows 7 Professional 64-
bit

 ×

Serviceability End user replaceable part: 
AC adapter

× ×
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2 External component identification

Locating hardware
To find out what hardware is installed on your computer:

1. From the Start screen, type control panel, and then select Control Panel.

‒ or –

From the Windows desktop, right-click the Start button, and then select Control Panel.

2. Select System and Security, select System, and then click Device Manager in the left column.

A list displays all the devices installed on your computer.

For information about system hardware components and the system BIOS version number, press fn+esc.

Locating software
To find out what software is installed on your computer:

▲ From the Start screen, click the down arrow in the lower-left corner of the screen.

‒ or –

From the Windows desktop, right-click the Start button, and then select Programs and Features.

Locating hardware 5



Display

Item Component Description

(1) WLAN antennas* Send and receive wireless signals to communicate with 
WLANs.

(2) Internal microphones Record sound.

(3) Webcam light On: The webcam is in use.

(4) Webcam Records video and captures photographs. Some models 
allow you to video conference and chat online using 
streaming video.

To use the webcam:

▲ From the Start screen, type camera, and then select 
Camera from the list of applications.

(5) Internal display switch Turns off the display and initiates Sleep if the display 
is closed while the power is on.

NOTE: The internal display switch is not visible 
from the outside of the computer.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately 
around the antennas free from obstructions. For wireless regulatory notices, see the section of the Regulatory, Safety, and 
Environmental Notices that applies to your country or region.

To access this document:

From the Start screen, type support, and then select the HP Support Assistant app.

‒ or –

From the Windows desktop, click the question mark icon in the notification area, at the far right of the taskbar.
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Keys

Item Component Description

(1) esc key Displays system information when pressed in combination 
with the fn key.

(2) fn key Displays system information when pressed in combination 
with the esc key.

(3) Windows key Returns you to the Start screen from an open app 
or the Windows desktop.

NOTE: Pressing the Windows key again will return you 
to the previous screen.

(4) Action keys Execute frequently used system functions.

NOTE: The f5 action key turns the radiance backlight 
keyboard feature off or on.

(5) Windows applications key Displays options for a selected object.

Keys 7



Lights

Item Component Description

(1) Caps lock light On: Caps lock is on, which switches the keys to all 
capital letters.

(2) Mute light ● Amber: Computer sound is off.

● Off: Computer sound is on.

Speakers

Component Description

Speakers Produce sound.
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TouchPad

Item Component Description

(1) TouchPad zone Reads your finger gestures to move the pointer or activate 
items on the screen.

(2) TouchPad left button Functions like the left button on an external mouse.

(3) TouchPad right button Functions like the right button on an external mouse.

TouchPad 9



Left side

Item Component Description

(1) Power connector Connects an AC adapter.

(2) AC adapter/battery light ● Solid white: The computer is connected to external 
power and the battery is fully charged.

● Solid amber: The computer is connected to 
external power and the battery is charged from 0 to 
99 percent.

● Slowly blinking white: A battery that is the only 
available power source has reached a low battery 
level. Less than 12 percent of the battery life is left.

● Quickly blinking white: A battery that is the only 
available power source has reached a critical battery 
level. Less than 7 percent of the battery life is left.

● Off: The computer is running on a battery 
as the power source.

(3) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool 
internal components and prevent overheating. It 
is normal for the internal fan to cycle on and off during 
routine operation.

(4) USB 3.0 charging (powered) port Connects an optional USB device, such as a keyboard, 
mouse, external drive, printer, scanner or USB hub. 
Standard USB ports will not charge all USB devices or will 
charge using a low current. Some USB devices require 
power and require you to use a powered port.

NOTE: USB charging ports can also charge select 
models of cell phones and MP3 players, even 
when the computer is off.

(5) Power button ● When the computer is off, press the button to turn 
on the computer.

● When the computer is on, press the button briefly to 
initiate Sleep.

● When the computer is in the Sleep state, 
press the button briefly to exit Sleep.

● When the computer is in Hibernation, 
press the button briefly to exit Hibernation.

CAUTION: Pressing and holding down the power button 
will result in the loss of unsaved information.
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Item Component Description

(5) Power button (continued) If the computer has stopped responding and Windows 
shutdown procedures are ineffective, press and 
hold the power button down for at least 5 seconds to turn 
off the computer.

To learn more about your power settings, see your 
power options.

▲ From the Start screen, type power, select Power and 
sleep settings, and then select Power and sleep 
from the list of applications.

‒ or –

From the Windows desktop, right-click the Start 
button, and then select Power Options.

(6) Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep state, a power-
saving state. The computer shuts off power 
to the display and other components.

● Off: The computer is off or in Hibernation. Hibernation 
is a power-saving state that uses the least amount 
of power.

(7) Memory card reader Reads optional memory cards that enable you to store, 
manage, share or access information.

To insert a card:

▲ Hold the card label-side up, with connectors 
facing the slot, insert the card into the slot, and then 
push in on the card until it is firmly seated.

To remove a card:

▲ Press in on the card it until it pops out.

Left side 11



Right side

Item Component Description

(1) Windows button Returns you to the Start screen from an open app 
or the Windows desktop.

NOTE: Pressing the Windows button again will return you 
to the previous screen.

(2) Volume button Controls speaker volume.

(3) Mini DisplayPort Connects an optional digital display device, such as a high-
performance monitor or projector.

(4) HDMI port Connects an optional video or audio device, such as a high-
definition television, any compatible digital or audio 
component, or a high-speed High-Definition Multimedia 
Interface (HDMI) device.

(5) USB 3.0 charging (powered) ports Connect an optional USB device, such as a keyboard, 
mouse, external drive, printer, scanner or USB hub. 
Standard USB ports will not charge all USB devices or will 
charge using a low current. Some USB devices require 
power and require you to use a powered port.

NOTE: USB charging ports can also charge select models 
of cell phones and MP3 players, even when the computer 
is off.

(6) Audio-out (headphone)/Audio-in (microphone) jack Connects optional powered stereo speakers, headphones, 
earbuds, a headset, or a television audio cable. Also 
connects an optional headset microphone. This jack does 
not support optional microphone-only devices.

WARNING! To reduce the risk of personal injury, 
adjust the volume before putting on headphones, earbuds, 
or a headset. For additional safety information, refer 
to the Regulatory, Safety, and Environmental Notices.

To access this document:

▲ From the Start screen, type support, and then 
select the HP Support Assistant app.

‒ or –

From the Windows desktop, click the question mark 
icon in the notification area, at the far right 
of the taskbar.

NOTE: When a device is connected 
to the jack, the computer speakers are disabled.

NOTE: Be sure that the device cable has a 4-conductor 
connector that supports both audio-out (headphone) and 
audio-in (microphone).
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3 Illustrated parts catalog

NOTE: HP continually improves and changes product parts. For complete and current information on 
supported parts for your computer, go to http://partsurfer.hp.com, select your country or region, and then 
follow the on-screen instructions.

Locating the serial number, product number, and model number
The product name (1), serial number (2), product number (3), warranty information (4), and model name (5) 
are located on the bottom of the computer. You may need this information when you travel internationally or 
when you contact support.

Locating the serial number, product number, and model number 13
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Computer major components
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Item Component Spare part number

(1) Display assembly: 13.3-in, ultra wide aspect ratio, TouchScreen (includes display panel cable, microphones, hinges, 
webcam, and wireless antenna cables and transceivers)

 13.3-in, QHD, WLED, BrightView (2560×1440), UWVA, 2.55-mm display assembly 801496-001

 13.3-in, FHD, WLED, BrightView (1920×1080), UWVA, 2.55-mm display assembly 801495-001

(2) Top cover 801509-001

(3) Keyboard (includes keyboard cable and keyboard backlight cable):

 For use on all computer models:

 For use in Belgium 801508-A41

 For use in Canada 801508-DB1

 For use in the Czech Republic and Slovakia 801508-FL1

 For use in Denmark, Finland, and Norway 801508-DH1

 For use in France 801508-051

 For use in Germany 801508-041

 For use in Greece 801508-151

 For use in Italy 801508-061

 For use in the Netherlands 801508-B31

 For use in Portugal 801508-131

 For use in Russia 801508-251

 For use in Saudi Arabia 801508-171

 For use in South Korea 801508-AD1

 For use in Spain 801508-071

 For use in Turkey 801508-141

 For use in the United Kingdom and Singapore 801508-031

 For use in the United States 801508-001

 For use only on HP Spectre Pro x360 Convertible PC computer models:

 For use in Israel 801508-BB1

 For use in Japan 801508-291

 For use only on HP Spectre x360 Convertible PC computer models:

 For use in Latin America 801508-161

 For use in Switzerland 801508-BG1

(4) Power connector cable 801513-001

(5) Audio jack board (includes cable) 801497-001

(6) TouchPad (includes cable) 801499-001

(7) Speakers (includes left and right speakers and cables) 801501-001
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Item Component Spare part number

(8) Card reader board (includes cable) 801498-001

(9) System board (includes a graphics subsystem with UMA memory and replacement thermal material):

 For use on all computer models:

 Equipped with an Intel Core i5-5200U 2.20-GHz (SC turbo up to 2.70-GHz) processor (1600-
MHz FSB, 4.00-MB L2 cache, dual core, 15 W), 8.0-GB of system memory, and the 
Windows 8 Professional operating system

801506-601

 Equipped with an Intel Core i5-5200U 2.20-GHz (SC turbo up to 2.70-GHz) processor (1600-
MHz FSB, 4.00-MB L2 cache, dual core, 15 W), 8.0-GB of system memory, and the 
Windows 8 Standard operating system

801506-501

 Equipped with an Intel Core i5-5200U 2.20-GHz (SC turbo up to 2.70-GHz) processor (1600-
MHz FSB, 4.00-MB L2 cache, dual core, 15 W), 8.0-GB of system memory, and a non-
Windows 8 operating system

801506-001

 Equipped with an Intel Core i5-5200U 2.20-GHz (SC turbo up to 2.70-GHz) processor (1600-
MHz FSB, 4.00-MB L2 cache, dual core, 15 W), 4.0-GB of system memory, and the 
Windows 8 Professional operating system

801507-601

 Equipped with an Intel Core i5-5200U 2.20-GHz (SC turbo up to 2.70-GHz) processor (1600-
MHz FSB, 4.00-MB L2 cache, dual core, 15 W), 4.0-GB of system memory, and the 
Windows 8 Standard operating system

801507-501

 Equipped with an Intel Core i5-5200U 2.20-GHz (SC turbo up to 2.70-GHz) processor (1600-
MHz FSB, 4.00-MB L2 cache, dual core, 15 W), 4.0-GB of system memory, and a non-
Windows 8 operating system

801507-001

 For use only on HP Spectre Pro x360 Convertible PC computer models:

 Equipped with an Intel Core i7-5600U 2.60-GHz (SC turbo up to 3.00-GHz) processor (1600-
MHz FSB, 4.00-MB L2 cache, dual core, 15 W), 8.0-GB of system memory, and the 
Windows 8 Professional operating system

808445-601

 Equipped with an Intel Core i7-5600U 2.60-GHz (SC turbo up to 3.00-GHz) processor (1600-
MHz FSB, 4.00-MB L2 cache, dual core, 15 W), 8.0-GB of system memory, and the 
Windows 8 Standard operating system

808445-501

 Equipped with an Intel Core i7-5600U 2.60-GHz (SC turbo up to 3.00-GHz) processor (1600-
MHz FSB, 4.00-MB L2 cache, dual core, 15 W), 8.0-GB of system memory, and a non-
Windows 8 operating system

808445-001

 Equipped with an Intel Core i5-5300U 2.30-GHz (SC turbo up to 2.90-GHz) processor (1600-
MHz FSB, 3.00-MB L2 cache, dual core, 15 W), 8.0-GB of system memory, and the 
Windows 8 Professional operating system

808444-601

 Equipped with an Intel Core i5-5300U 2.30-GHz (SC turbo up to 2.90-GHz) processor (1600-
MHz FSB, 3.00-MB L2 cache, dual core, 15 W), 8.0-GB of system memory, and the 
Windows 8 Standard operating system

808444-501

 Equipped with an Intel Core i5-5300U 2.30-GHz (SC turbo up to 2.90-GHz) processor (1600-
MHz FSB, 3.00-MB L2 cache, dual core, 15 W), 8.0-GB of system memory, and a non-
Windows 8 operating system

808444-001

 Equipped with an Intel Core i5-5300U 2.30-GHz (SC turbo up to 2.90-GHz) processor (1600-
MHz FSB, 3.00-MB L2 cache, dual core, 15 W), 4.0-GB of system memory, and the 
Windows 8 Professional operating system

808443-601

 Equipped with an Intel Core i5-5300U 2.30-GHz (SC turbo up to 2.90-GHz) processor (1600-
MHz FSB, 3.00-MB L2 cache, dual core, 15 W), 4.0-GB of system memory, and the 
Windows 8 Standard operating system

808443-501
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Item Component Spare part number

 Equipped with an Intel Core i5-5300U 2.30-GHz (SC turbo up to 2.90-GHz) processor (1600-
MHz FSB, 3.00-MB L2 cache, dual core, 15 W), 4.0-GB of system memory, and a non-
Windows 8 operating system

808443-001

 For use only on HP Spectre x360 Convertible PC computer models:

 Equipped with an Intel Core i7-5500U 2.40-GHz (SC turbo up to 3.00-GHz) processor (1600-
MHz FSB, 4.00-MB L2 cache, dual core, 15 W), 8.0-GB of system memory, and the 
Windows 8 Professional operating system

801505-601

 Equipped with an Intel Core i7-5500U 2.40-GHz (SC turbo up to 3.00-GHz) processor (1600-
MHz FSB, 4.00-MB L2 cache, dual core, 15 W), 8.0-GB of system memory, and the 
Windows 8 Standard operating system

801505-501

 Equipped with an Intel Core i7-5500U 2.40-GHz (SC turbo up to 3.00-GHz) processor (1600-
MHz FSB, 4.00-MB L2 cache, dual core, 15 W), 8.0-GB of system memory, and a non-
Windows 8 operating system

801505-001

(10) Heat sink (includes replacement thermal material) 801494-001

(11) Solid-state drive:

 For use on all computer models:

 512-GB, M2, SATA3 solid-state drive supporting TLC 801504-001

 256-GB, M2, SATA3 solid-state drive supporting TLC 801503-001

 128-GB, M2, SATA3 solid-state drive supporting TLC 801502-001

 For use only on HP Spectre Pro x360 Convertible PC computer models:

 256-GB, M2, SATA3 SED solid-state drive supporting MLC 813147-001

 180-GB, M2, SATA3 solid-state drive supporting MLC 808446-001

 128-GB, M2, SATA3 solid-state drive supporting MLC 813146-001

(12) WLAN module:

 Intel Dual Band Wireless-AC 7265 802.11 ac 2×2 WiFi + Bluetooth 4.0 Combo Adapter for 
use only on HP Spectre x360 Convertible PC computer models

756751-005

 Intel Dual Band Wireless-N 7265BN 802.11 b/g/n 2×2 WiFi + Bluetooth 4.0 Combo Adapter 
for use only on HP Spectre x360 Convertible PC computer models

780308-005

 Intel Dual Band Wireless-AC 7265 802.11 ac 2×2 WiFi + Bluetooth 4.0 Combo Adapter for 
use only on HP Spectre Pro x360 Convertible PC computer models

756749-005

 Intel Dual Band Wireless-N 7265BN 802.11 a/b/g/n 2×2 WiFi + Bluetooth 4.0 Combo 
Adapter for use only on HP Spectre Pro x360 Convertible PC computer models

756748-005

(13) Fan (includes cable) 801493-001

(14) Battery, 3-cell, 56-WHr, 4.96-AHr, Li-ion (includes cable) 789116-005

(15) Bottom cover (includes 4 rubber feet) 801492-001

Miscellaneous parts

Component Spare part number

AC adapter:
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Component Spare part number

65-W HP Smart adapter (non-PFC, EM, 3-wire, 4.5-mm) for use on all computer models 714657-001

45-W HP Smart adapter (non-PFC, RC, 3-wire, 4.5-mm) for use on all computer models 741727-001

45-W HP Smart adapter (non-PFC, RC, 3-wire, 4.5-mm) for use only on HP Spectre Pro x360 
Convertible PC computer models

742436-001

HP sleeve 806206-001

HP HDMI-to-VGA adapter 701943-001

HP RJ45-to-USB adapter dongle 539614-001

Power cord (3-pin, black, 1.83-m):

For use on all computer models:

For use in Australia 490371-011

For use in Denmark 490371-081

For use in Europe 490371-021

For use in North America 490371-001

For use in South Korea 490371-AD1

For use in Switzerland 490371-111

For use in the United Kingdom and Singapore 490371-031

For use only on HP Spectre Pro x360 Convertible PC computer models:

For use in Israel 490371-BB1

For use in the People’s Republic of China 490371-AA1

For use only on HP Spectre x360 Convertible PC computer models:

For use in India 490371-D61

For use in South Africa 490371-AR1

Power cord (3-pin, black, 1.00-m):

For use only on HP Spectre Pro x360 Convertible PC computer models:

For use in Australia 755530-011

For use in Denmark 755530-081

For use in Europe 755530-021

For use in Israel 755530-BB1

For use in the People’s Republic of China 755530-AA1

For use in South Korea 755530-AD1

For use in Switzerland 755530-111

For use in the United Kingdom and Singapore 755530-031

Power cord for use only in Japan (2-pin, black, 1.00-m) 762689-291

Screw Kit 801500-001
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4 Removal and replacement preliminary 
requirements

Tools required
You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screw driver

● Magnetic screw driver

● Phillips P0 screw driver

Service considerations
The following sections include some of the considerations that you must keep in mind during disassembly 
and assembly procedures.

NOTE: As you remove each subassembly from the tablet, place the subassembly (and all accompanying 
screws) away from the work area to prevent damage.

Plastic parts

CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use care 
when handling the plastic parts. Apply pressure only at the points designated 
in the maintenance instructions.

Cables and connectors

CAUTION: When servicing the tablet, be sure that cables are placed in their proper locations 
during the reassembly process. Improper cable placement can damage the tablet.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat or 
seat the cables during removal and insertion. Handle cables by the connector whenever possible. In all cases, 
avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that they cannot be 
caught or snagged by parts being removed or replaced. Handle flex cables with extreme care; these cables 
tear easily.
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Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure 
determine the degree of sensitivity. Networks built into many integrated circuits provide some protection, 
but in many cases, ESD contains enough power to alter device parameters or melt silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or 
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a normal 
cycle. Or the device may function normally for a while, then degrade in the internal layers, reducing its life 
expectancy.

CAUTION: To prevent damage to the tablet when you are removing or installing internal components, 
observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Before touching an electronic component, discharge static electricity by using the guidelines described in 
this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by 
different activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that mechanized 
equipment used for moving materials is wired to ground and that proper materials are selected to avoid 
static charging. When grounding is not possible, use an ionizer to dissipate electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded tools and 
equipment.

● Use conductive field service tools, such as cutters, screw drivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-
safe materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids 
and Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle these 
items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps with a 
minimum of one megohm ±10% resistance in the ground cords. To provide proper ground, wear a strap 
snugly against the skin at all times. On grounded mats with banana-plug connectors, use alligator clips 
to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps) can be 
used at standing workstations and are compatible with most types of shoes or boots. On conductive 
floors or dissipative floor mats, use foot straps on both feet with a minimum of one megohm resistance 
between the operator and ground. To be effective, the conductive must be worn in contact 
with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastics Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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5 Removal and replacement procedures

NOTE: This chapter provides removal and replacement procedures for Authorized Service Provider only 
components. Components described in this chapter should only be accessed by an authorized service 
provider. Accessing these components can damage the computer or void the warranty.

There are as many as [] screws that must be removed, replaced, and/or loosened when 
servicing the computer. Make special note of each screw size and location during removal and replacement.

NOTE: HP continually improves and changes product parts. For complete and current information on 
supported parts for your computer, go to http://partsurfer.hp.com, select your country or region, and then 
follow the on-screen instructions.

Unlocking the device and disabling Always On Remote 
Management (select HP devices only)

NOTE: This section applies only to HP Spectre Pro x360 Convertible PC computer models.

HP Touchpoint Manager (HPTM) is a complete cloud-based solution for managing devices. For select 
HP devices with the Windows operating system, the Always On Remote Management (AORM) feature is 
automatically activated when HP Touchpoint Manager software is installed.

AORM can perform a secure BIOS level lock and can also securely erase internal drives (except for encrypted 
self-encrypting drives). The HP Touchpoint Manager website (http://www.hptouchpointmanager.com) 
provides access to the AORM lock feature. The device must be unlocked using an authorized PIN 
from the same website before you can access HP Computer Setup and start the Windows operating system.

IMPORTANT: A service agent cannot retrieve the PIN from the HP Touchpoint Manager website. If a locked 
device is returned for service, the agent must contact the customer to obtain the PIN to unlock the device. If a 
PIN is not available, the entire system board must be replaced.

Before returning the device for service, be sure to unlock the device using the PIN from the HP Touchpoint 
Manager website (http://www.hptouchpointmanager.com), and also disable the AORM feature in 
HP Computer Setup.

To disable AORM:

1. Access HP Computer Setup (F10).

a. Turn on or restart the device, and then press esc while the “Press the ESC key for Startup Menu” 
message is displayed at the bottom of the screen.

b. Press f10 to enter Computer Setup.

NOTE: If the BIOS is protected with an Administrator password, enter the password.

2. Select Advanced, and then select HP Touchpoint Manager Options.

3. Clear the Allow Activation check box.

4. Select Save changes and exit.
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Bottom cover

Description Spare part number

Bottom cover (includes 4 rubber feet) 801492-001

Before disassembling the computer, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, 
turn the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

Remove the bottom cover:

1. Close the computer.

2. Turn the computer upside down with the front toward you.

3. Remove the two Torx5 T5M2.0×8.0 screws (1) and the six Torx5 T5M2.0×3.9 screws (2) that 
secure the bottom cover to the computer.

4. Separate the rear edge of the bottom cover (1) from the top cover until it rests at an angle.
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5. Remove the bottom cover (2).

6. Turn the computer right side up, with the front toward you.

Reverse this procedure to install the bottom cover.

Battery

Description Spare part number

Battery, 3-cell, 56-WHr, 4.96-AHr, Li-ion (includes cable) 789116-005

Before removing the battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, 
turn the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet 
and then unplugging the AC adapter from the computer.

4. Remove the bottom cover (see Bottom cover on page 24).

WARNING! To reduce potential safety issues, use only the battery provided with the computer, a 
replacement battery provided by HP, or a compatible battery purchased from HP.

CAUTION: Removing a battery that is the sole power source for the computer can cause loss of information. 
To prevent loss of information, save your work or shut down the computer through Windows before 
removing the battery.

Remove the battery:

1. Disconnect the battery cable (1) from the system board.

2. Release the battery cable from the routing channel (2) built into the battery.

3. Release the speaker cable from the routing channel (3) built into the battery.
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4. Remove the four PM2.0×4.0 screws (4) that secure the battery to the top cover.

5. Remove the battery (5).

Reverse this procedure to install the battery.

WLAN module

Description Spare part number

Intel Dual Band Wireless-AC 7265 802.11 ac 2×2 WiFi + Bluetooth 4.0 Combo Adapter for use only on 
HP Spectre x360 Convertible PC computer models

756751-005

Intel Dual Band Wireless-N 7265BN 802.11 b/g/n 2×2 WiFi + Bluetooth 4.0 Combo Adapter for use only 
on HP Spectre x360 Convertible PC computer models

780308-005

Intel Dual Band Wireless-AC 7265 802.11 ac 2×2 WiFi + Bluetooth 4.0 Combo Adapter for use only on 
HP Spectre Pro x360 Convertible PC computer models

756749-005

Intel Dual Band Wireless-N 7265BN 802.11 a/b/g/n 2×2 WiFi + Bluetooth 4.0 Combo Adapter for use 
only on HP Spectre Pro x360 Convertible PC computer models

756748-005

CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless module 
authorized for use in the computer by the governmental agency that regulates wireless devices in your 
country or region. If you replace the module and then receive a warning message, remove the module to 
restore device functionality, and then contact technical support.

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, 
turn the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet 
and then unplugging the AC adapter from the computer.
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4. Remove the bottom cover (see Bottom cover on page 24).

5. Disconnect the battery cable from the system board (see Battery on page 25).

Remove the WLAN module:

1. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The WLAN antenna cable labeled “1” connects to the WLAN module “Main” terminal labeled 
“1”. The WLAN antenna cable labeled “2” connects to the WLAN module “Aux” terminal labeled “2”.

2. Remove the Phillips PM2.0×2.7 screw (2) that secures the WLAN module to the top cover. (The WLAN 
module tilts up.)

3. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

NOTE: If the WLAN antenna cables are not connected to the terminals on the WLAN module, protective 
sleeves should be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WLAN module.
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Solid-state drive

Description Spare part number

For use on all computer models:

512-GB, M2, SATA3 solid-state drive supporting TLC 801504-001

256-GB, M2, SATA3 solid-state drive supporting TLC 801503-001

128-GB, M2, SATA3 solid-state drive supporting TLC 801502-001

For use only on HP Spectre Pro x360 Convertible PC computer models:

256-GB, M2, SATA3 SED solid-state drive supporting MLC 813147-001

180-GB, M2, SATA3 solid-state drive supporting MLC 808446-001

128-GB, M2, SATA3 solid-state drive supporting MLC 813146-001

Before removing the solid-state drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, 
turn the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet 
and then unplugging the AC adapter from the computer.

4. Remove the bottom cover (see Bottom cover on page 24).

5. Disconnect the battery cable from the system board (see Battery on page 25).

Remove the solid-state drive:

1. Remove the PM2.0×2.9 screw (1) that secures the solid-state drive to the bottom cover. (The solid-
state drive tilts up.)

2. Remove the solid-state drive (2) by pulling the drive away from the slot at an angle.

Reverse this procedure to install the solid-state drive.
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Fan

Description Spare part number

Fan (includes cable) 801493-001

NOTE: To properly ventilate the computer, allow at least 7.6 cm (3 in) of clearance on the left side 
of the computer. The computer uses an electric fan for ventilation. The fan is controlled by a temperature 
sensor and is designed to turn on automatically when high temperature conditions exist. These conditions 
are affected by high external temperatures, system power consumption, power management/battery 
conservation configurations, battery fast charging, and software requirements. Exhaust air is displaced 
through the ventilation grill located on the left side of the computer.

Before removing the fan, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, 
turn the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet 
and then unplugging the AC adapter from the computer.

4. Remove the bottom cover (see Bottom cover on page 24).

5. Disconnect the battery cable from the system board (see Battery on page 25).

Remove the fan:

1. Disconnect the fan cable (1) from the system board.

2. Remove the two Phillips PM2.0×4.0 screws (2) that secure the fan to the top cover.

3. Remove the fan (3).

Reverse this procedure to install the fan.
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Speakers

Description Spare part number

Speakers (include left and right speakers and cables) 801501-001

Before removing the speakers, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, 
turn the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet 
and then unplugging the AC adapter from the computer.

4. Remove the bottom cover (see Bottom cover on page 24).

5. Disconnect the battery cable from the system board (see Battery on page 25).

Remove the speakers:

1. Disconnect the speaker cables (1) from the system board.

2. Remove the three Phillips PM2.0×2.7 screws (2) that secure the speakers to the top cover.

3. Remove the speakers (3).

Reverse this procedure to install the speakers.
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TouchPad
NOTE: The TouchPad spare part kit includes the TouchPad cable.

Description Spare part number

For use only on computer models equipped with an AMD processor 801499-001

Before removing the TouchPad, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, 
turn the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the bottom cover (see Bottom cover on page 24).

5. Remove the battery (see Battery on page 25).

Remove the TouchPad:

1. Release the zero insertion force (ZIF) connector (1) to which the TouchPad cable is attached, and then 
disconnect the TouchPad cable from the system board.

2. Remove the five Phillips PM1.5×2.3 screws (2) that secure the TouchPad to the top cover.
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3. Remove the TouchPad and cable.

Reverse this procedure to install the TouchPad.

Card reader board

Description Spare part number

Card reader board (includes cable) 801498-001

Before removing the card reader board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, 
turn the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the bottom cover (see Bottom cover on page 24).

5. Remove the battery (see Battery on page 25).

6. Remove the speakers (see Speakers on page 30).

Remove the card reader board:

1. Release the ZIF connector (1) to which the card reader board cable is attached, and then 
disconnect the card reader board cable from the system board.

2. Remove the Phillips PM2.0×2.7 screws (2) that secure the card reader board to the top cover.
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3. Remove the card reader board (3) and cable from the top cover.

4. Remove the card reader board.

Reverse this procedure to install the card reader board.

System board
NOTE: The system board spare part kit includes a graphics subsystem with UMA memory and replacement 
thermal material.

Description Spare part number

For use on all computer models:

Equipped with an Intel Core i5-5200U 2.20-GHz (SC turbo up to 2.70-GHz) processor (1600-MHz FSB, 
4.00-MB L2 cache, dual core, 15 W), 8.0-GB of system memory, and the Windows 8 Professional 
operating system

801506-601

Equipped with an Intel Core i5-5200U 2.20-GHz (SC turbo up to 2.70-GHz) processor (1600-MHz FSB, 
4.00-MB L2 cache, dual core, 15 W), 8.0-GB of system memory, and the Windows 8 Standard 
operating system

801506-501

Equipped with an Intel Core i5-5200U 2.20-GHz (SC turbo up to 2.70-GHz) processor (1600-MHz FSB, 
4.00-MB L2 cache, dual core, 15 W), 8.0-GB of system memory, and a non-Windows 8 operating system

801506-001

Equipped with an Intel Core i5-5200U 2.20-GHz (SC turbo up to 2.70-GHz) processor (1600-MHz FSB, 
4.00-MB L2 cache, dual core, 15 W), 4.0-GB of system memory, and the Windows 8 Professional 
operating system

801507-601

Equipped with an Intel Core i5-5200U 2.20-GHz (SC turbo up to 2.70-GHz) processor (1600-MHz FSB, 
4.00-MB L2 cache, dual core, 15 W), 4.0-GB of system memory, and the Windows 8 Standard 
operating system

801507-501

Equipped with an Intel Core i5-5200U 2.20-GHz (SC turbo up to 2.70-GHz) processor (1600-MHz FSB, 
4.00-MB L2 cache, dual core, 15 W), 4.0-GB of system memory, and a non-Windows 8 operating system

801507-001

For use only on HP Spectre Pro x360 Convertible PC computer models:
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Description Spare part number

Equipped with an Intel Core i7-5600U 2.60-GHz (SC turbo up to 3.00-GHz) processor (1600-MHz FSB, 
4.00-MB L2 cache, dual core, 15 W), 8.0-GB of system memory, and the Windows 8 Professional 
operating system

808445-601

Equipped with an Intel Core i7-5600U 2.60-GHz (SC turbo up to 3.00-GHz) processor (1600-MHz FSB, 
4.00-MB L2 cache, dual core, 15 W), 8.0-GB of system memory, and the Windows 8 Standard 
operating system

808445-501

Equipped with an Intel Core i7-5600U 2.60-GHz (SC turbo up to 3.00-GHz) processor (1600-MHz FSB, 
4.00-MB L2 cache, dual core, 15 W), 8.0-GB of system memory, and a non-Windows 8 operating system

808445-001

Equipped with an Intel Core i5-5300U 2.30-GHz (SC turbo up to 2.90-GHz) processor (1600-MHz FSB, 
3.00-MB L2 cache, dual core, 15 W), 8.0-GB of system memory, and the Windows 8 Professional 
operating system

808444-601

Equipped with an Intel Core i5-5300U 2.30-GHz (SC turbo up to 2.90-GHz) processor (1600-MHz FSB, 
3.00-MB L2 cache, dual core, 15 W), 8.0-GB of system memory, and the Windows 8 Standard 
operating system

808444-501

Equipped with an Intel Core i5-5300U 2.30-GHz (SC turbo up to 2.90-GHz) processor (1600-MHz FSB, 
3.00-MB L2 cache, dual core, 15 W), 8.0-GB of system memory, and a non-Windows 8 operating system

808444-001

Equipped with an Intel Core i5-5300U 2.30-GHz (SC turbo up to 2.90-GHz) processor (1600-MHz FSB, 
3.00-MB L2 cache, dual core, 15 W), 4.0-GB of system memory, and the Windows 8 Professional 
operating system

808443-601

Equipped with an Intel Core i5-5300U 2.30-GHz (SC turbo up to 2.90-GHz) processor (1600-MHz FSB, 
3.00-MB L2 cache, dual core, 15 W), 4.0-GB of system memory, and the Windows 8 Standard 
operating system

808443-501

Equipped with an Intel Core i5-5300U 2.30-GHz (SC turbo up to 2.90-GHz) processor (1600-MHz FSB, 
3.00-MB L2 cache, dual core, 15 W), 4.0-GB of system memory, and a non-Windows 8 operating system

808443-001

For use only on HP Spectre x360 Convertible PC computer models:

Equipped with an Intel Core i7-5500U 2.40-GHz (SC turbo up to 3.00-GHz) processor (1600-MHz FSB, 
4.00-MB L2 cache, dual core, 15 W), 8.0-GB of system memory, and the Windows 8 Professional 
operating system

801505-601

Equipped with an Intel Core i7-5500U 2.40-GHz (SC turbo up to 3.00-GHz) processor (1600-MHz FSB, 
4.00-MB L2 cache, dual core, 15 W), 8.0-GB of system memory, and the Windows 8 Standard 
operating system

801505-501

Equipped with an Intel Core i7-5500U 2.40-GHz (SC turbo up to 3.00-GHz) processor (1600-MHz FSB, 
4.00-MB L2 cache, dual core, 15 W), 8.0-GB of system memory, and a non-Windows 8 operating system

801505-001

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, 
turn the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet 
and then unplugging the AC adapter from the computer.

4. Remove the bottom cover (see Bottom cover on page 24).

5. Remove the battery (see Battery on page 25).

6. Remove the fan (see Fan on page 29).
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When replacing the system board, be sure that the following components are removed 
from the defective system board and installed on the replacement system board:

● WLAN module (see WLAN module on page 26)

● Solid-state drive (see Solid-state drive on page 28)

● Heat sink (see Heat sink on page 37)

Remove the system board:

1. Release the ZIF connector (1) to which the audio jack cable is attached, and then disconnect the audio 
jack cable from the system board.

2. Disconnect the WLAN antenna cables (2) from the terminals on the WLAN module.

NOTE: The WLAN antenna cable labeled “1” connects to the WLAN module “Main” terminal labeled 
“1”. The WLAN antenna cable labeled “2” connects to the WLAN module “Aux” terminal labeled “2”.

3. Release the ZIF connector (3) to which the display panel cable is attached, and then 
disconnect the display panel cable from the system board.

4. Disconnect the power connector cable (4) from the system board.

5. Disconnect the speaker cables (1) from the system board.

6. Release the ZIF connector (2) to which the keyboard backlight cable is attached, and then 
disconnect the keyboard backlight cable from the system board.

7. Release the ZIF connector (3) to which the keyboard cable is attached, and then 
disconnect the keyboard cable from the system board.

8. Release the ZIF connector (4) to which the TouchPad cable is attached, and then 
disconnect the TouchPad cable from the system board.
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9. Release the ZIF connector (5) to which the card reader board cable is attached, and then 
disconnect the card reader board cable from the system board.

10. Remove the Phillips PM2.0×2.6 broad head screw (1) and the Phillips PM2.0×2.7 screw (2) that secure 
the system board to the top cover.

11. Lift the front edge system board (3) until it rests at an angle.

12. Remove the system board (4) by sliding it up and forward at an angle.

Reverse this procedure to install the system board.
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Heat sink

Description Spare part number

Heat sink (includes replacement thermal material) 801494-001

Before removing the heat sink, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, 
turn the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet 
and then unplugging the AC adapter from the computer.

4. Remove the bottom cover (see Bottom cover on page 24), and then remove the following components:

a. Remove the battery (see Battery on page 25).

b. Remove the fan (see Fan on page 29).

c. Remove the system board (see System board on page 33).

Remove the heat sink:

1. Loosen the four captive Phillips PM2.0×2.7 screws (1) that secure the heat sink to the system board.

NOTE: Due to the adhesive quality of the thermal material located between the heat sink and system 
board components, it may be necessary to move the heat sink from side to side to detach it.

2. Remove the heat sink (2).

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink and the system 
board each time the heat sink is removed. Thermal paste is used on the processor (1) and the heat sink 
section (2) that services it.
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Reverse this procedure to install the heat sink.

Keyboard
NOTE: The keyboard spare part kit includes the keyboard cable and the keyboard backlight cable.

For use in country or region Spare part number For use in country or region Spare part number

For use on all computer models: For use in the Netherlands 801508-B31

For use in Belgium 801508-A41 For use in Portugal 801508-131

For use in Canada 801508-DB1 For use in Russia 801508-251

For use in the Czech Republic 
and Slovakia

801508-FL1 For use in Saudi Arabia 801508-171

For use in Denmark, Finland, 
and Norway

801508-DH1 For use in South Korea 801508-AD1

For use in France 801508-051 For use in Spain 801508-071

For use in Germany 801508-041 For use in Turkey 801508-141

For use in Greece 801508-151 For use in the United Kingdom 
and Singapore

801508-031

For use in Italy 801508-061 For use in the United States 801508-001

For use only on HP Spectre Pro x360 Convertible PC computer models:

For use in Israel 801508-BB1 For use in Japan 801508-291

For use only on HP Spectre x360 Convertible PC computer models:

For use in Latin America 801508-161 For use in Switzerland 801508-BG1
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Before removing the keyboard, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, 
turn the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the bottom cover (see Bottom cover on page 24), and then remove the following components:

a. Remove the battery (see Battery on page 25).

b. Remove the fan (see Fan on page 29).

c. Remove the system board (see System board on page 33).

Remove the keyboard:

1. Remove the 55 Phillips PM1.1×1.5 screws that secure the keyboard to the top cover from the locations 
in the following illustration.

2. Remove the keyboard shields (1).
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3. Remove the keyboard (2).

Reverse this procedure to install the keyboard.

Display assembly

Description Spare part number

13.3-in, ultra wide aspect ratio, TouchScreen 13.3-in, QHD, WLED, BrightView (2560×1440), UWVA, 
2.55-mm display assembly (includes display panel cable, microphones, hinges, webcam, and wireless 
antenna cables and transceivers)

801496-001

13.3-in, ultra wide aspect ratio, TouchScreen 13.3-in, FHD, WLED, BrightView (1920×1080), UWVA, 
2.55-mm display assembly (includes display panel cable, microphones, hinges, webcam, and wireless 
antenna cables and transceivers)

801495-001

Before removing the display assembly, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, 
turn the computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the bottom cover (see Bottom cover on page 24), and then remove the following components:

a. Remove the battery (see Battery on page 25).

b. Remove the fan (see Fan on page 29).

c. Remove the system board (see System board on page 33).

Remove the display assembly:
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1. Open the computer to the interactive position, as shown in the following illustrations.

2. Release the WLAN antenna cables from the retention post (1) built into the top cover.

3. Release the display panel cable from the retention post (2) built into the top cover.

4. Remove the four Phillips PM2.5×4.1 screws (1) that secure the display assembly to the top cover.

5. Slide the display assembly (2) forward until the display hinges (3) clear the top cover.

6. Remove the display assembly (4).

Reverse this procedure to install the display assembly.
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Audio jack board

Description Spare part number

Audio jack board (includes cable) 801497-001

Before removing the audio jack board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, 
turn the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet 
and then unplugging the AC adapter from the computer.

4. Remove the bottom cover (see Bottom cover on page 24), and then remove the following components:

a. Remove the battery (see Battery on page 25).

b. Remove the fan (see Fan on page 29).

c. Remove the system board (see System board on page 33).

d. Remove the display assembly (see Display assembly on page 40).

Remove the audio jack board:

1. Remove the Phillips PM2.0×2.0 broad head screw (1) that secures the audio jack board to the top cover.

2. Remove the audio jack board (2).

Reverse this procedure to install the audio jack board.
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Power connector cable

Description Spare part number

Power connector cable 801513-001

Before removing the power connector cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, 
turn the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet 
and then unplugging the AC adapter from the computer.

4. Remove the bottom cover (see Bottom cover on page 24), and then remove the following components:

a. Remove the battery (see Battery on page 25).

b. Remove the fan (see Fan on page 29).

c. Remove the system board (see System board on page 33).

d. Remove the display assembly (see Display assembly on page 40).

Remove the power connector cable:

1. Release the power connector cable (1) from the retention clips built into the bottom cover.

2. Remove the Phillips PM2.0×4.1 screw (2) that secures the power connector to the top cover.

3. Remove the power connector cable (3).

Reverse this procedure to install the power connector cable.
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6 Using Setup Utility (BIOS) – Windows 8

Setup Utility, or Basic Input/Output System (BIOS), controls communication between all the input and output 
devices on the system (such as disk drives, display, keyboard, mouse, and printer). Setup Utility (BIOS) 
includes settings for the types of devices installed, the startup sequence of the computer, and the amount 
of system and extended memory.

NOTE: To start the Setup Utility, your computer must be in notebook mode and you must use the keyboard 
attached to your notebook. The on-screen keyboard which displays in tablet mode cannot 
access the Setup Utility.

Starting Setup Utility (BIOS)
CAUTION: Use extreme care when making changes in Setup Utility (BIOS). Errors can prevent the computer 
from operating properly.

▲ Turn on or restart the computer, quickly press esc, and then press f10.

Updating the BIOS
Updated versions of the BIOS may be available on the HP website.

Most BIOS updates on the HP website are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding installing 
and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than the one currently installed 
on the computer, you need to know the version of the system BIOS that is installed.

BIOS version information (also known as ROM date and System BIOS) can be revealed from the Start screen by 
typing support, selecting the HP Support Assistant app, and then selecting System Information, or by 
using Setup Utility (BIOS).

1. Start Setup Utility (BIOS) (see Starting Setup Utility (BIOS) on page 44).

2. Select Main, and then make note of your BIOS version.

3. Select Exit, select Exit Discarding Changes, and then follow the on-screen instructions.
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Downloading a BIOS update

CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download and 
install a BIOS update only when the computer is connected to reliable external power using the AC adapter. 
Do not download or install a BIOS update while the computer is running on battery power, docked in an 
optional docking device, or connected to an optional power source. During the download and installation, 
follow these instructions:

● Do not disconnect power from the computer by unplugging the power cord from the AC outlet.

● Do not shut down the computer or initiate Sleep.

● Do not insert, remove, connect, or disconnect any device, cable, or cord.

NOTE: If your computer is connected to a network, consult the network administrator before installing any 
software updates, especially system BIOS updates.

1. From the Start screen, type support, and then select the HP Support Assistant app.

‒ or –

From the Windows desktop, click the question mark icon in the notification area, at the far right 
of the taskbar.

2. Click Updates and tune-ups, and then click Check for HP updates now.

3. Follow the on-screen instructions.

4. At the download area, follow these steps:

a. Identify the most recent BIOS update and compare it to the BIOS version currently installed on 
your computer. If the update is more recent than your BIOS, make a note of the date, name, or 
other identifier. You may need this information to locate the update later, after it has been 
downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive.

If the update is more recent than your BIOS, make a note of the path to the location on your hard 
drive where the BIOS update is downloaded. You will need to access this path when you are ready 
to install the update.

BIOS installation procedures vary. Follow any instructions that appear on the screen after the download 
is complete. If no instructions appear, follow these steps:

1. From the Start screen, type file, and then select File Explorer.

‒ or –

From the Windows desktop, right-click the Start button, and then select File Explorer.

2. Click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3. Using the hard drive path you recorded earlier, open the folder on your hard drive that 
contains the update.

4. Double-click the file that has an .exe extension (for example, filename.exe).

The BIOS installation begins.

5. Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete the downloaded file 
from your hard drive.
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7 Using HP PC Hardware Diagnostics (UEFI) – 
Windows 8

HP PC Hardware Diagnostics is a Unified Extensible Firmware Interface (UEFI) that allows you to run 
diagnostic tests to determine whether the computer hardware is functioning properly. The tool runs 
outside the operating system so that it can isolate hardware failures from issues that are caused 
by the operating system or other software components.

NOTE: To start the Setup Utility, your computer must be in notebook mode and you must use the keyboard 
attached to your notebook. The on-screen keyboard which displays in tablet mode cannot 
access the Setup Utility.

To start HP PC Hardware Diagnostics (UEFI):

1. Start Setup Utility, by turning on or restarting the computer, and then quickly pressing the esc key.

2. Press or tap f2.

The BIOS searches 3 places for the diagnostic tools, in the following order:

a. Connected USB drive

NOTE: To download the HP PC Hardware Diagnostics (UEFI) tool to a USB drive, see Downloading 
HP PC Hardware Diagnostics (UEFI) to a USB device on page 47.

b. Hard drive

c. BIOS

3. When the diagnostic tool opens, use the keyboard arrow keys to select the type of diagnostic test you 
want to run, and then follow the on-screen instructions.

NOTE: If you need to stop a diagnostic test, press the esc key.
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Downloading HP PC Hardware Diagnostics (UEFI) to a USB device
NOTE: Instructions for downloading HP PC Hardware Diagnostics (UEFI) are provided in English only.

There are two options to download HP PC Hardware Diagnostics to a USB device:

Option 1: HP PC Diagnostics homepage— Provides access to the latest UEFI version

1. Go to http://www.hp.com/go/techcenter/pcdiags.

2. Click the Download link under HP PC Hardware Diagnostics, and then select Run.

Option 2: Support and Drivers pages—Provide downloads for a specific product for earlier and 
later versions

1. Go to http://www.hp.com.

2. Point to Support, located at the top of the page, and then click Download Drivers.

3. In the text box, enter the product name, and then click Go.

– or –

Click Find Now to let HP automatically detect your product.

4. Select your computer model, and then select your operating system.

5. In the Diagnostic section, click HP UEFI Support Environment.

– or –

Click Download, and then select Run.
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8 Using Setup Utility (BIOS) and HP PC 
Hardware Diagnostics (UEFI) – Windows 7

Setup Utility, or Basic Input/Output System (BIOS), controls communication between all the input and output 
devices on the system (such as disk drives, display, keyboard, mouse, and printer). Setup Utility (BIOS) 
includes settings for the types of devices installed, the startup sequence of the computer, and the amount 
of system and extended memory.

NOTE: To start the Setup Utility, your computer must be in notebook mode and you must use the keyboard 
attached to your notebook. The on-screen keyboard which displays in tablet mode cannot 
access the Setup Utility.

Starting Setup Utility (BIOS)
▲ To start Setup Utility (BIOS), turn on or restart the computer, quickly press esc, and then press f10.

NOTE: Use extreme care when making changes in Setup Utility (BIOS). Errors can prevent the computer 
from operating properly.

Updating the BIOS
Updated versions of the BIOS may be available on the HP website.

Most BIOS updates on the HP website are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding installing 
and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed 
on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed by pressing fn+esc (if 
you are already in Windows) or by using Setup Utility (BIOS).

1. Start Setup Utility (BIOS).

2. Use the arrow keys to select Main, and then make note of your current BIOS version.

3. To exit Setup Utility (BIOS) without saving your changes, use the tab key and the arrow keys to select 
Exit > Exit Discarding Changes, and then press enter.
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Downloading a BIOS update

CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download and 
install a BIOS update only when the computer is connected to reliable external power using the AC adapter. 
Do not download or install a BIOS update while the computer is running on battery power, docked in an 
optional docking device, or connected to an optional power source. During the download and installation, 
follow these instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Sleep or Hibernation.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Select Start > All Programs > HP Help and Support > HP Support Assistant.

2. Follow the on-screen instructions to identify your computer and access the BIOS update you want 
to download.

3. At the download area, follow these steps:

a. Identify the BIOS update that is later than the BIOS version currently installed on your computer. 
Make a note of the date, name, or other identifier. You may need this information to 
locate the update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive.

Make a note of the path to the location on your hard drive where the BIOS update is downloaded. 
You will need to access this path when you are ready to install the update.

NOTE: If you connect your computer to a network, consult the network administrator before installing 
any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are displayed on the screen 
after the download is complete. If no instructions are displayed, follow these steps:

1. Open Windows Explorer by selecting Start > Computer.

2. Double-click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3. Using the hard drive path you recorded earlier, open the folder on your hard drive that 
contains the update.

4. Double-click the file that has an .exe extension (for example, filename.exe).

The BIOS installation begins.

5. Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete the downloaded file 
from your hard drive.
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Using HP PC Hardware Diagnostics (UEFI)
HP PC Hardware Diagnostics is a Unified Extensible Firmware Interface (UEFI) that allows you to run 
diagnostic tests to determine whether the computer hardware is functioning properly. The tool runs 
outside the operating system so that it can isolate hardware failures from issues that are caused 
by the operating system or other software components.

NOTE: To start the Setup Utility, your computer must be in notebook mode and you must use the keyboard 
attached to your notebook. The on-screen keyboard which displays in tablet mode cannot 
access the Setup Utility.

To start HP PC Hardware Diagnostics UEFI:

1. Start Setup Utility, by turning on or restarting the computer, and then quickly pressing the esc key.

2. Press or tap f2.

The BIOS searches 3 places for the diagnostic tools, in the following order:

a. Connected USB drive

NOTE: To download the HP PC Hardware Diagnostics (UEFI) tool to a USB drive, see Downloading 
HP PC Hardware Diagnostics (UEFI) to a USB device on page 47.

b. Hard drive

c. BIOS

3. When the diagnostic tool opens, use the keyboard arrow keys to select the type of diagnostic test you 
want to run, and then follow the on-screen instructions.

NOTE: If you need to stop a diagnostic test, press esc.
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Downloading HP PC Hardware Diagnostics (UEFI) to a USB device

NOTE: Instructions for downloading HP PC Hardware Diagnostics (UEFI) are provided in English only.

There are two options to download HP PC Hardware Diagnostics to a USB device.

Download the latest UEFI version:

1. Go to http://www.hp.com/go/techcenter/pcdiags. The HP PC Diagnostics home page is displayed.

2. Click the Download link in the HP PC Hardware Diagnostics section, and then select Run.

Download any version of UEFI for a specific product:

1. Go to http://www.hp.com/support, and then select your country. The HP Support page is displayed.

2. Click Drivers & Downloads.

3. In the text box, enter the product name, and then click Go.

– or –

Click Find Now to let HP automatically detect your product.

4. Select your computer model, and then select your operating system.

5. In the Diagnostic section, click HP UEFI Support Environment.

– or –

Click Download, and then select Run.
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9 Specifications

 Metric U.S.

Dimensions

Width 32.5 cm 12.80 in

Depth 21.8 cm 8.58 in

Height (front to rear) 1.54 to 1.60 cm 0.61 to 0.63 in

Weight (equipped with solid-state drive) 1.50 kg 3.30 lbs

Input power

Operating voltage and current 19.5 V dc @ 2.31 A – 45 W

19.5 V dc @ 3.33 A – 65 W

NOTE: This product is designed for IT power systems in Norway with phase-to-phase voltage not exceeding 240 V rms.

NOTE: The computer operating voltage and current can be found on the system regulatory label.

Temperature

Operating 5°C to 35°C 41°F to 95°F

Nonoperating ‑20°C to 60°C ‑4°F to 140°F

Relative humidity (noncondensing)

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating ‑15 m to 3,048 m ‑50 ft to 10,000 ft

Nonoperating ‑15 m to 12,192 m ‑50 ft to 40,000 ft

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The device operates well within this range 
of temperatures.
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10 Backing up, restoring, and recovering – 
Windows 8

This chapter provides information about the following processes. The information in the chapter is standard 
procedure for most models.

● Creating recovery media and backups

● Restoring and recovering your system

For additional information, refer to the HP Support Assistant.

▲ From the Start screen, type support, and then select the HP Support Assistant app.

- or -

From the Windows desktop, click the question mark icon in the notification area, at the far right 
of the taskbar.

Creating recovery media and backups
The following methods of creating recovery media and backups are available on select models only. 
Choose the available method according to your computer model.

● Use HP Recovery Manager after you successfully set up the computer to create HP Recovery media. 
This step creates a backup of the HP Recovery partition on the computer. The backup can be used to 
reinstall the original operating system in cases where the hard drive is corrupted or has been replaced. 
For information on creating recovery media, see Creating HP Recovery media (select models only) 
on page 54. For information on the recovery options that are available using the recovery media, see 
Recovering using HP Recovery Manager on page 56.

● Use Windows tools to create system restore points and create backups of personal information. 

For more information, see Using Windows tools on page 55.

NOTE: If storage is 32 GB or less, Microsoft System Restore is disabled by default.
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Creating HP Recovery media (select models only)

IMPORTANT: If your computer does not list a Recovery Media Creation option, you can obtain recovery 
media for your system from support. See the Worldwide Telephone Numbers booklet included 
with the computer. You can also find contact information from the HP website. Go to http://www.hp.com/
support, select your country or region, and follow the on-screen instructions.

HP Recovery Manager is a software program that allows you to create recovery media after you successfully 
set up the computer. HP Recovery media can be used to perform system recovery if the hard drive becomes 
corrupted. System recovery reinstalls the original operating system and the software programs installed 
at the factory and then configures the settings for the programs. HP Recovery media can also be used to 
customize the system or restore the factory image if you replace the hard drive.

● Only one set of recovery media can be created. Handle these recovery tools carefully, and keep them in 
a safe place.

● HP Recovery Manager examines the computer and determines the required storage capacity 
for the media that will be required.

● To create recovery discs, your computer must have an optical drive with DVD writer capability, and you 
must use only high-quality blank DVD-R, DVD+R, DVD-R DL, or DVD+R DL discs. Do not use rewritable 
discs such as CD±RW, DVD±RW, double-layer DVD±RW, or BD-RE (rewritable Blu-ray) discs; they are not 
compatible with HP Recovery Manager software. Or, instead, you can use a high-quality blank USB 
flash drive. 

● If your computer does not include an integrated optical drive with DVD writer capability, but you would 
like to create DVD recovery media, you can use an external optical drive (purchased separately) to 
create recovery discs, or you can obtain recovery discs for your computer from support. 
See the Worldwide Telephone Numbers booklet included with the computer. You can also find contact 
information from the HP website. Go to http://www.hp.com/support, select your country or region, and 
follow the on-screen instructions. If you use an external optical drive, it must be connected directly to a 
USB port on the computer; the drive cannot be connected to a USB port on an external device, such as a 
USB hub.

● Be sure that the computer is connected to AC power before you begin creating the recovery media.

● The creation process can take an hour or more. Do not interrupt the creation process.

● If necessary, you can exit the program before you have finished creating all of the recovery DVDs. 
HP Recovery Manager will finish burning the current DVD. The next time you start HP Recovery Manager, 
you will be prompted to continue, and the remaining discs will be burned.

To create HP Recovery media:

1. From the Start screen, type recovery, and then select HP Recovery Manager.

2. Select Recovery Media Creation, and then follow the on-screen instructions.

If you ever need to recover the system, see Recovering using HP Recovery Manager on page 56.
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Using Windows tools
You can create system restore points and create backups of personal information using Windows tools. 

NOTE: If storage is 32 GB or less, Microsoft System Restore is disabled by default.

▲ From the Start screen, type help, and then select Help and Support.

‒ or –

From the Windows desktop, click the question mark icon in the notification area, at the far right 
of the taskbar.

For more information and steps, see Help and Support.

Restore and recovery
There are several options for recovering your system. Choose the method that best matches your situation 
and level of expertise:

IMPORTANT: Not all methods are available on all models.

● Windows offers several options for restoring from backup, refreshing the computer, and 
resetting the computer to its original state. For more information see Help and Support.

▲ From the Start screen, type support, and then select the HP Support Assistant app.

- or -

From the Windows desktop, click the question mark icon in the notification area, at the far right 
of the taskbar.

● If you need to correct a problem with a preinstalled application or driver, use the Drivers and 
Applications Reinstall option of HP Recovery Manager to reinstall the individual application or driver.

▲ From the Start screen, type recovery, select HP Recovery Manager, select Drivers and 
Applications Reinstall, and then follow the on-screen instructions.

● On select models, if you want to reset your computer using a minimized image, you can 
choose the HP Minimized Image Recovery option from the HP Recovery partition or HP Recovery media. 
Minimized Image Recovery installs only drivers and hardware-enabling applications. Other applications 
included in the image continue to be available for installation through the Drivers and Applications 
Reinstall option in HP Recovery Manager.

For more information, see Recovering using HP Recovery Manager on page 56.

● If you want to recover the Windows partition to original factory content, you can choose the System 
Recovery option from the HP Recovery partition (select models only) or use the HP Recovery media. For 
more information, see Recovering using HP Recovery Manager on page 56. If you have not already 
created recovery media, see Creating HP Recovery media (select models only) on page 54.

● On select models, if you want to recover the computer's original factory partition and content , or if you 
have replaced the hard drive, you can use the Factory Reset option of HP Recovery media. For more 
information, see Recovering using HP Recovery Manager on page 56.

● On select models, if you want to remove the recovery partition to reclaim hard drive space, HP Recovery 
Manager offers the Remove Recovery Partition option.

For more information, see Removing the HP Recovery partition (select models only) on page 57.
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Recovering using HP Recovery Manager

HP Recovery Manager software allows you to recover the computer to its original factory state by 
using the HP Recovery media that you either created or that you obtained from support, or by 
using the HP Recovery partition (select models only). If you have not already created recovery media, see 
Creating HP Recovery media (select models only) on page 54.

What you need to know before you get started

● HP Recovery Manager recovers only software that was installed at the factory. For software not 
provided with this computer, you must either download the software from the manufacturer's website 
or reinstall the software from the media provided by the manufacturer.

IMPORTANT: Recovery through HP Recovery Manager should be used as a final attempt to correct 
computer issues.

● HP Recovery media must be used if the computer hard drive fails. If you have not already created 
recovery media, see Creating HP Recovery media (select models only) on page 54.

● To use the Factory Reset option (select models only), you must use HP Recovery media. If you have not 
already created recovery media, see Creating HP Recovery media (select models only) on page 54.

● If your computer does not allow the creation of HP Recovery media or if the HP Recovery media does 
not work, you can obtain recovery media for your system from support. See the Worldwide Telephone 
Numbers booklet included with the computer. You can also find contact information 
from the HP website. Go to http://www.hp.com/support, select your country or region, and 
follow the on-screen instructions.

IMPORTANT: HP Recovery Manager does not automatically provide backups of your personal data. Before 
beginning recovery, back up any personal data you want to retain.

Using HP Recovery media, you can choose from one of the following recovery options:

NOTE: Only the options available for your computer display when you start the recovery process.

● System Recovery—Reinstalls the original operating system, and then configures the settings 
for the programs that were installed at the factory.

● Minimized Image Recovery (select models only)—Reinstalls the operating system and all hardware-
related drivers and software, but not other software applications.

● Factory Reset—Restores the computer to its original factory state by deleting all information 
from the hard drive and re-creating the partitions. Then it reinstalls the operating system 
and the software that was installed at the factory.

The HP Recovery partition (select models only) allows System Recovery and Minimized Image Recovery 
(select models only).

Using the HP Recovery partition (select models only)

The HP Recovery partition allows you to perform a system recovery or minimized image recovery (select 
models only) without the need for recovery discs or a recovery USB flash drive. This type of recovery can be 
used only if the hard drive is still working.

To start HP Recovery Manager from the HP Recovery partition:

1. From the Start screen, type recovery, select Recovery Manager, and then select HP Recovery 
Environment.

- or-
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Press f11 while the computer boots, or press and hold f11 as you press the power button.

2. Select Troubleshoot from the boot options menu.

3. Select Recovery Manager, and then follow the on-screen instructions.

Using HP Recovery media to recover

You can use HP Recovery media to recover the original system. This method can be used if your system does 
not have an HP Recovery partition or if the hard drive is not working properly.

1. If possible, back up all personal files.

2. Insert the HP Recovery media, and then restart the computer.

NOTE: If the computer does not automatically restart in HP Recovery Manager, change the computer 
boot order. See Changing the computer boot order on page 57.

3. Follow the on-screen instructions.

Changing the computer boot order

If your computer does not restart in HP Recovery Manager, you can change the computer boot order, which 
is the order of devices listed in BIOS where the computer looks for startup information. You can 
change the selection for an optical drive or a USB flash drive.

To change the boot order:

1. Insert the HP Recovery media.

2. Start Computer Setup:

▲ Turn on or restart the computer, quickly press esc, and then press f9 for boot options.

3. Select the optical drive or USB flash drive from which you want to boot.

4. Follow the on-screen instructions.

Removing the HP Recovery partition (select models only)

HP Recovery Manager software allows you to remove the HP Recovery partition to free up hard drive space.

IMPORTANT: After you remove the HP Recovery partition, you can no longer use the Windows Refresh 
option or the Windows option to remove everything and reinstall Windows. In addition, you will not be able to 
perform System Recovery or Minimized Image Recovery from the HP Recovery partition. So before you 
remove the Recovery partition, create HP Recovery media; see Creating HP Recovery media (select models 
only) on page 54.

Follow these steps to remove the HP Recovery partition:

1. From the Start screen, type recovery, and then select HP Recovery Manager.

2. Select Remove Recovery Partition, and then follow the on-screen instructions.
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11 Backing up, restoring, and recovering – 
Windows 7

Your computer includes tools provided by the operating system and HP to help you safeguard your 
information and retrieve it if ever needed.

Creating backups
1. Use HP Recovery Manager to create recovery media immediately after you set up the working 

computer.

2. As you add hardware and software programs, create system restore points.

3. As you add photos, video, music, and other personal files, create a backup of your system and personal 
information.

Creating recovery media to recover the original system

After you successfully set up the computer, you should create recovery discs or a recovery flash drive using 
HP Recovery Manager. You will need these recovery discs or recovery flash drive to perform a system 
recovery should the hard drive become corrupted. A system recovery reinstalls the original operating system, 
and then configures the settings for the default programs.

What you need to know

● Only one set of recovery media can be created. Handle these recovery tools carefully, and keep them in 
a safe place.

● HP Recovery Manager examines the computer and determines the required storage capacity 
for the flash drive or the number of blank DVD discs that will be required.

Use DVD-R, DVD+R, DVD-R DL, DVD+R DL discs or a flash drive. Do not use rewriteable discs such as CD
±RW, DVD±RW, double-layer DVD±RW, and BD-RE (rewritable Blu-ray) discs; they are not compatible 
with HP Recovery Manager software.

● If your computer does not include an integrated optical drive, you can use an optional external optical 
drive (purchased separately) to create recovery discs, or you can obtain recovery discs for your 
computer from the HP website. If you use an external optical drive, it must be connected directly to a 
USB port on the computer, not to a USB port on an external device, such as a USB hub.

● Be sure that the computer is connected to AC power before you begin creating the recovery media.

● The creation process can take up to an hour or more. Do not interrupt the creation process.

● Store the recovery media in a safe location, separate from the computer.

● If necessary, you can exit the program before you have finished creating the recovery media. The next 
time you open HP Recovery Manager, you will be prompted to continue the process.
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Creating the recovery media

1. Select Start and type recovery in the search field. Select Recovery Manager from the list. 
Allow the action to continue, if prompted.

2. Click Recovery Media Creation.

3. Follow the on-screen instructions to continue.

To recover, see Recovering the original system using HP Recovery Manager on page 62.

Creating system restore points

A system restore point is a snapshot of certain hard drive contents saved by Windows System Restore at a 
specific time. A restore point contains information such as registry settings that Windows uses. Restoring to 
a previous restore point allows you to reverse changes that have been made to the system since the restore 
point was created.

Restoring to an earlier system restore point does not affect data files saved or emails created since the last 
restore point, but it does affect software you may have installed.

For example, if you download a photo from a digital camera and then restore the computer to the state it was 
on the previous day, the photo remains on the computer.

However, if you install photo viewing software and then restore your computer to the state it was 
on the previous day, the software will be uninstalled, and you won't be able to use it.

What you need to know

● If you restore to a restore point and then change your mind, you can undo the restoration.

● You should create system restore points:

◦ Before you add or change software or hardware

◦ Periodically, whenever the computer is running normally

● System Restore also saves shadow copies of files that have been changed since the last restore point 
was created. For more information about using shadow copies to restore, see Help and Support.

Creating a system restore point

1. Select Start > Control Panel > System and Security > System.

2. In the left pane, click System Protection.

3. Click the System Protection tab.

4. Click Create, and follow the on-screen instructions.

To restore, see Restoring to a previous system restore point on page 61.
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Backing up system and personal information

Your computer stores information that is important to you, such as files, emails, and photos, and you will 
want to keep that information even if you download a virus or the system stops working properly. How 
completely you are able to recover your files depends on how recent your backup is. As you add new 
software and data files, you should create backups on a regular basis.

Tips for a successful backup

● Number backup discs before inserting them into the optical drive.

● Store personal files in the Documents, Music, Pictures, and Videos libraries, and back up these folders 
periodically.

● Save customized settings in a window, toolbar, or menu bar by taking a screen shot of your settings. 
The screen shot can be a time-saver if you have to re-enter your preferences.

To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:

To copy only the active window, press alt+prt sc.

To copy the entire screen, press prt sc.

3. Open a word-processing document or graphics editing program, and then select Edit > Paste. The 
screen image is added to the document.

4. Save and print the document.

What you need to know

● You can back up your information to an optional external hard drive, a flash drive, a network drive, or 
discs.

● Connect the computer to AC power during backups.

● Allow enough time for the backup. Depending on files sizes, it may take more than an hour.

● Verify the amount of free space on your backup storage device before you back up.

● You should back up:

◦ Before adding or changing software or hardware.

◦ Before the computer is repaired or restored.

◦ On a regular schedule to be sure you have recent copies of personal information.

◦ After you add many files—for example, if you saved videos from a birthday party.

◦ Before using antivirus software to remove a malicious program.

◦ After adding information that is hard to replace, such as pictures, videos, music, project files, or 
data records.
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Creating a backup using Windows Backup and Restore

Windows allows you to back up files using Windows Backup and Restore. You can select the level you want to 
back up, from individual folders to drives. The backups are compressed to save space. To back up:

1. Select Start > Control Panel > System and Security > Backup and Restore.

2. Follow the on-screen instructions to schedule and create a backup.

NOTE: Windows includes the User Account Control feature to improve the security of the computer. You 
may be prompted for your permission or password for tasks such as installing software, running utilities, or 
changing Windows settings. See Help and Support for more information.

To restore, see Restoring specific files using Windows Backup and Restore on page 61.

Restore and recovery

Restoring to a previous system restore point

Sometimes installing a software program causes your computer or Windows to behave unpredictably. 
Usually uninstalling the software fixes the problems. If uninstalling does not fix the problems, you can 
restore the computer to a previous system restore point (created at an earlier date and time).

To restore to a previous system restore point, when the computer was running correctly:

1. Select Start > Control Panel > System and Security > System.

2. In the left pane, click System Protection.

3. Click the System Protection tab.

4. Click System Restore, and follow the on-screen instructions.

Restoring specific files

If files are accidentally deleted from the hard disk and they can no longer be restored from the Recycle Bin, or 
if files become corrupt, restoring specific files is useful. Restoring specific files is also useful if you ever 
choose to recover the original system using HP Recovery Manager. You can only restore specific files that you 
have backed up before.

Restoring specific files using Windows Backup and Restore

Windows allows you to restore files that were backed up using Windows Backup and Restore:

1. Select Start > Control Panel > System and Security > Backup and Restore.

2. Follow the on-screen instructions to restore your backup.

NOTE: Windows includes the User Account Control feature to improve the security of the computer. You 
may be prompted for your permission or password for tasks such as installing software, running utilities, or 
changing Windows settings. See Help and Support for more information.
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Recovering the original system using HP Recovery Manager

HP Recovery Manager software allows you to repair or recover the computer to its original factory state.

What you need to know

● HP Recovery Manager recovers only software that was installed at the factory. For software not 
provided with this computer, you must either download the software from the manufacturer's website 
or reinstall the software from the disc provided by the manufacturer.

● A system recovery should be used as a final attempt to correct computer issues. If you have not already 
tried restore points (see Restoring to a previous system restore point on page 61) and partial restores 
(see Restoring specific files on page 61), try them before using HP Recovery Manager to recover your 
system.

● A system recovery must be performed if the computer hard drive fails or if all attempts to correct any 
functional computer issues fail.

● If the recovery media do not work, you can obtain recovery discs for your system from the HP website.

● The Minimized Image Recovery option is recommended for advanced users only. All hardware-related 
drivers and software are re-installed, but other software applications are not. Do not 
interrupt the process until it is complete, otherwise the recovery will fail.

Recovering using HP Recovery partition (select models only)

The HP Recovery partition (select models only), allows you to restore your system without the need for 
recovery discs or a recovery flash drive. This type of recovery can only be used if the hard drive is still 
working.

To check for the presence of a recovery partition, select Start, right-click Computer then select Manage > 
Disk Management. If the recovery partition is present, a Recovery drive is listed in the window.

NOTE: Recovery discs have been included if your computer did not ship with a recovery partition.

1. Access HP Recovery Manager in either of the following ways:

● Select Start and type recovery in the search field. Select Recovery Manager from the list.

– or –

● Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup 
Menu” message is displayed at the bottom of the screen. Then press f11 while the “F11 (System 
Recovery)” message is displayed on the screen.

2. Click System Recovery in the HP Recovery Manager window.

3. Follow the on-screen instructions.
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Recovering using the recovery media

1. If possible, back up all personal files.

2. Insert the first recovery disc into the optical drive on your computer or an optional external optical 
drive, and then restart the computer.

– or –

Insert the recovery flash drive into a USB port on your computer, and then restart the computer.

NOTE: If the computer does not automatically restart in HP Recovery Manager, change the computer 
boot order. See Changing the computer boot order on page 63.

3. Press f9 at system bootup.

4. Select the optical drive or the flash drive.

5. Follow the on-screen instructions.

Changing the computer boot order

To change the boot order for recovery discs:

1. Restart the computer.

2. Press esc while the computer is restarting, and then press f9 for boot options.

3. Select Internal CD/DVD ROM Drive from the boot options window.

To change the boot order for a recovery flash drive:

1. Insert the flash drive into a USB port.

2. Restart the computer.

3. Press esc while the computer is restarting, and then press f9 for boot options.

4. Select the flash drive from the boot options window.
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12 Statement of Volatility

NOTE: This chapter applies only to HP Spectre Pro x360 Convertible PC computer models.

The purpose of this document is to provide general information regarding non-volatile memory in industry-
standards based HP Business Notebook PC systems and provide general instructions for restoring 
nonvolatile memory that can contain personal data after the system has been powered off and the hard drive 
has been removed.

HP Business Notebook PC products that use Intel-based or AMD®-based system boards contain volatile DDR 
memory. The amount of nonvolatile memory present in the system depends upon the system configuration. 
Intel-based and AMD-based system boards contain nonvolatile memory subcomponents as originally 
shipped from HP assuming that no subsequent modifications have been made to the system and assuming 
that no applications, features, or functionality have been added to or installed on the system.

Following system shutdown and removal of all power sources from an HP Business Notebook PC system, 
personal data can remain on volatile system memory (DIMMs) for a finite period of time and will also remain 
in nonvolatile memory. The steps below will remove personal data from the notebook PC, 
including the nonvolatile memory found in Intel-based and AMD-based system boards. Some of these steps 
are disclosed in the Maintenance and Service Guides available for HP PC products available on the product 
support pages at www.hp.com.

1. Follow steps (a) through (I) below to restore the nonvolatile memory that can contain personal data. 
Restoring or re-programming nonvolatile memory that does not store personal data is neither 
necessary nor recommended.

a. Enter BIOS (F10) Setup by powering on the system and pressing F10 when prompted 
near the bottom of the display, or press the ESC key to display the start up menu, then press F10 . 
If the system has a BIOS administrator password, enter the password at the prompt.

b. Select the File menu, then Restore Defaults.

c. Select the System Configuration menu, then Restore Security Defaults.

d. If an asset or ownership tag is set, select the Security menu and scroll down to the Utilities menu. 
Select System IDs, and then select the tag that has been set. Press the spacebar once to 
clear the tag, then press Enter to return to the prior menu.

e. If a DriveLock password is set, select the Security menu, scroll down to DriveLock, then select 
DriveLock password. Select the desired hard drive. Click Disable protection, enter the existing 
master DriveLock password, then press Enter to confirm and return to the prior menu. Repeat 
this procedure if more than one hard drive has a DriveLock password.

f. If an Automatic DriveLock password is set, select the Security menu, scroll down to Automatic 
DriveLock, then select the desired hard drive and disable protection. Repeat this procedure if 
more than one hard drive has an Automatic DriveLock password.

g. Select the File menu, then Reset BIOS Security to factory default. Click yes at the warning 
message.

h. Select the File menu, then Save Changes and Exit.
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i. Reboot the system. If the system has a Trusted Platform Module and/or fingerprint sensor, one or 
two prompts will appear: one to clear the TPM and the other to reset fingerprint sensor. Press F1 
to accept or F2 to reject.

If the HP notebook model number ends in a ‘p’ or ‘w’ and includes Intel Centrino with VProTM, 
reboot the PC and enter BIOS Setup by pressing F10 when prompted. Select System 
Configuration, then AMT Options. Then select Un-configure AMT on next boot. Select Save, then 
Yes. Select the File menu, and then select Save Changes and Exit. Reboot the system and confirm 
that you want to un-configure AMT.

j. If the optional Intel Anti-Theft Technology (AT) was activated, contact the provider to deactivate it.

k. If the optional Absolute® Software Computrace® management and tracking service was activated 
on the notebook PC, contact the provider to deactivate it.

l. Remove all power and system batteries for at least 24 hours.

2. Remove and retain the storage drive or clear the contents of the drive.

a. Hard Disk Drive (HDD)

Clear the HDD contents by using the HP Disk Sanitizer® utility or a third party application that, 
ideally, is U.S. Department of Defense (DOD) 5220.22-M approved.

To run HP Disk Sanitizer, enter BIOS Setup by powering on the system and pressing F10 when 
prompted near the bottom of the display, or press ESC to display the start up menu, then press 
F10. Select the Security menu and scroll down to the Utilities menu. Select Disk Sanitizer and 
select the desired drive. For a higher level of protection, select Optimum.

NOTE: This process will take a long time, and the amount of time varies based on the hard drive 
capacity.

b. Solid State Drive (SSD)

Clear the SSD contents by using the BIOS Setup Secure Erase command option, or by using a third 
party utility designed to erase data from an SSD. To run Secure Erase, enter BIOS Setup by 
powering on the system and pressing F10 when prompted near the bottom of the display. 
Select the Security menu and scroll down to the Utilities menu. Select Secure Erase and 
select the desired hard drive.
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Non-volatile memory usage

Non Volatile 
Memory Type

Amount (Size) Does 
this memory 
store customer 
data?

Does 
this memory 
retain data 
when power 
is removed?

What 
is the purpose 
of this memory?

How is data 
input into 
this memory?

How 
is this memory 
write 
protected?

Real Time Clock 
(RTC) battery 
backed-up CMOS 
configuration 
memory (CMOS)

256 Bytes No Yes Stores system 
date and time 
and limited 
keyboard 
controller data.

Using the F10 
Setup utility or 
changing the Mic
rosoft Windows 
date and time.

This memory 
is not write-
protected. 
HP recommends 
password 
protecting the F
10 Setup utility.

Controller (NIC) 
EEPROM

64 KBytes (not 
customer 
accessible)

No Yes Store NIC 
configuration 
and NIC 
firmware.

Using a utility 
from the NIC 
vendor that can 
be run from DOS.

A utility 
is required to 
write data to 
this memory and 
is available from 
NIC vendor. 
Writing data to 
this ROM in an 
inappropriate 
manner will 
render the NIC 
nonfunctional.

Keyboard ROM 64 KBytes (not 
customer 
accessible)

No Yes Stores firmware 
code (keyboard, 
mouse, & 
battery 
management).

Programmed 
at the factory. 
Code is updated 
when the system 
BIOS is updated.

A utility 
is required for 
writing data to 
this memory and 
is available 
on the HP websit
e. Writing data 
to this ROM in an 
inappropriate 
manner can 
render the PC 
nonfunctional.

DIMM Serial 
Presence Detect 
(SPD) 
configuration 
data

256 Bytes per 
memory 
module, 128 
Bytes 
programmable 
(not customer 
accessible)

No Yes Stores memory 
module 
information.

Programmed 
by the memory 
vendor.

Data cannot be 
written to 
this memory 
when the modul
e is installed in a 
PC. The specific 
write protection 
method varies 
by memory 
vendor.

System BIOS 4 to 5 MBytes Yes Yes Store system 
BIOS code and 
PC configuration 
data.

System BIOS 
code 
is programmed 
at the factory. 
Code is updated 
when the system 
BIOS is updated. 
Configuration 
data and 
settings are 
input 

A utility 
is required for 
writing data to 
this memory and 
is available 
on the HP websit
e. Writing data 
to this ROM in an 
inappropriate 
manner can 
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Non Volatile 
Memory Type

Amount (Size) Does 
this memory 
store customer 
data?

Does 
this memory 
retain data 
when power 
is removed?

What 
is the purpose 
of this memory?

How is data 
input into 
this memory?

How 
is this memory 
write 
protected?

using the F10 
setup utility or a 
custom utility.

render the PC 
nonfunctional.

Intel 
Management 
Engine Firmware 
(present only in 
models ending in 
a ‘p’ or ‘w’ or 
with Intel 
Centrino Pro 
technology)

1.5 or 5 MBytes Yes Yes Stores 
Management 
Engine Code, 
Settings, 
Provisioning 
Data and iAMT 
third party data 
store.

Management 
Engine Code 
is programmed 
at the factory. 
Code is updated 
via Intel secure 
firmware update 
utility. Unique 
Provisioning 
Data can be 
entered 
at the factory or 
by an 
administrator 
using the Manag
ement Engine 
(MEBx) setup 
utility. The third 
party data store 
contents can 
populated by a 
remote 
management 
console or local 
applications 
registered by an 
administrator to 
have access 
to the space.

The Intel chipset 
is configured to 
enforce 
hardware 
protection to 
block all direct 
read/write 
access to 
this area. An 
Intel utility 
is required for 
updating the fir
mware. Only 
firmware 
updates digitally 
signed by Intel 
can be applied 
using this utility.

Bluetooth flash 2 MBits No Yes Stores Bluetooth 
configuration 
and firmware.

Programmed 
at the factory. 
Tools for writing 
data to 
this memory are 
not publicly 
available but can 
be obtained 
from the silicon 
vendor.

A utility 
is required for 
writing data to 
this memory and 
is made 
available 
through newer 
versions 
of the driver 
if the flash 
requires an 
upgrade.

802.11 WLAN 
EEPROM

4 KBytes to 8 
KBytes

No Yes Stores 
configuration 
and calibration 
data.

Programmed 
at the factory. 
Tools for writing 
data to 
this memory are 
not made public.

A utility 
is required for 
writing data to 
this memory and 
is typically not 
made available 
to the public 
unless a 
firmware 
upgrade 
is necessary to 
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Non Volatile 
Memory Type

Amount (Size) Does 
this memory 
store customer 
data?

Does 
this memory 
retain data 
when power 
is removed?

What 
is the purpose 
of this memory?

How is data 
input into 
this memory?

How 
is this memory 
write 
protected?

address a unique 
issue.

Webcamera 64 KBits No Yes Store webcam 
configuration 
and firmware.

Using a utility 
from the device 
manufacturer 
that can be run 
from Windows.

A utility 
is required for 
writing data to 
this memory and 
is typically not 
made available 
to the public 
unless a 
firmware 
upgrade 
is necessary to 
address a unique 
issue.

Fingerprint 
reader

512 KBytes flash Yes Yes Stores 
fingerprint 
templates.

By enrolling in 
HP ProtectTools 
Security 
Manager.

Only a digitally 
signed 
application can 
make the call to 
write 
to the flash.

Questions and answers
1. How can the BIOS settings be restored (returned to default settings)?

a. Turn on or restart the computer and press F10 when prompted near the bottom of the display.

b. Select File, then select Restore defaults.

c. Follow the on-screen instructions.

d. Select File, save changes and exit, then press Enter.

2. What kind of configuration data is stored on the DIMM Serial Presence Detect (SPD) memory 
module? How would this data be written?

The DIMM SPD memory contains information about the memory module such as size, serial number, 
data width, speed/timing, voltage and thermal information. This information is written by the module 
manufacturer and stored on an EEPROM. This EEPROM cannot be written to when the memory module 
is installed in a PC. Third party tools do exist that can write to the EEPROM when the memory module 
is not installed in a PC. There are various third party tools available to read SPD memory.

3. Does the “Firmware Hub for System BIOS” contain the BIOS program? Is this chip writable, and if so 
how?

The Firmware Hub does contain the BIOS program and is writable. A utility is required to 
perform the write function.

4. In some PC systems, the Firmware Hub for System BIOS is a flash memory chip so that updates can 
be written by the customer. Is this true for these BIOS chips?

Yes, they are flash memory chips.
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5. What is meant by “Restore the nonvolatile memory found in Intel-based system boards?”

This relates to clearing the Real Time Clock (RTC) CMOS memory that contains PC configuration data.

6. Does resetting the CMOS configuration memory return the PC back to factory defaults?

The process of resetting the CMOS will return certain system settings to factory default but will not 
reset many of the system data and configuration defaults to their default settings. To return these 
system data and configuration defaults to default settings, refer to question and answer 1 and 
follow the instructions for returning the BIOS settings to factory defaults.
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13 Power cord set requirements

The wide-range input feature of the computer permits it to operate from any line voltage from 100 to 120 
volts AC, or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the country or 
region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or region 
where the computer is used.

Requirements for all countries
The following requirements are applicable to all countries and regions:

● The length of the power cord set must be at least 1.0 m (3.3 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for evaluation 
in the country or region where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage rating 
of 125 or 250 V AC, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 Standard Sheet 
C13 connector for mating with the appliance inlet on the back of the computer. Requirements for all 
countries 113

Requirements for specific countries and regions

Country/region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China COC 5
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Country/region Accredited agency Applicable note number

South Korea EK 4

Sweden CEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler and 
wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be 
used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding type 
with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance 
with the Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall 
plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler and wall 
plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler and wall 
plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be used.
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14 Recycling

When a non-rechargeable or rechargeable battery has reached the end of its useful life, do not dispose 
of the battery in general household waste. Follow the local laws and regulations in your area for battery 
disposal.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and rechargeable 
batteries. For more information about recycling programs, see the HP Web site at http://www.hp.com/
recycle.
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